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ICT 12012 - INFORMATION TECHNOLOGY -II 

 

Introduction: 

 
This course provides basic to a level of intermediate knowledge on network, communication and 

internet usages. The presentation applications module provides knowledge on MS PowerPoint 

presentation application for multi-media presentations. The database management module 

provides the main application for this course is the MS Access. The course provides Database 

management procedures such as relationship, queries and forms and lead students to develop a 

database application. 

 

Objective of the Course. 

• Understand the concept of communication.  

• Use network applications 

• Use PowerPoint software and their multi-media presentations. 

• Understand Database software and their general applications 

• Use relationship, queries and forms on data. 

 

Learning Outcomes of the Course: 

By the end of the course students will be able to; 

• Understand and distinguish various types of networks 

• Create power point presentation files 

• Perform a skilled presentation. 

• Understand database management 

• Demonstrate the ability to manipulate data by queries and forms 

• Use Built-in- database Functions. 

• Create a database application 

 

 

Method of Teaching & Learning (TL): 
Students do not require any previous knowledge or experience with computers to follow this 

course. The following TL methods will be used to illustrate the various topics of the course.  

 

TL 1 Lecture  

TL 2 Practical 

 

Method of Evaluation: 

- Semester-End Written Examination - 70% 

- Continuous Assessment   - 30% 
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Unit 1 Data Communication  

1.1 Concepts and Definitions 

1.2 Data Transmission modes 

 

1.1 Concepts and Definitions 

Data communication is the process of sending data electronically from one computer or similar 

device to another. Thus, making the sharing of data, hardware, and software possible. In many 

companies the trend has been away from using a single large computer to several smaller 

machines connected together. 

 

Computers within the same room or groups of buildings can share data directly through cables; 

while computers far apart uses various form of data communication, such as telecommunication, 

to share data. Telecommunication is the use of a communication facility, such as a telephone 

system or microwave relays (radio stations), to send data between devices. 

 

Data communication today considers numerous factors, including cost of hardware, software, 

and performance of devices when networking computers. This consideration is given to ensure 

that the selected means of communicating will be long-lasting for current and future standards 

of communicating. 

 

Two computers are said to be interconnected if they are able to exchange information’s. The 

connection need not be via a copper wire; fiber optics, microwaves, and communication satellites 

can also be used. By requiring the computer to be autonomous, we which to execute from our 

definitions systems in which there is a clear master/slave relation. If one computer can forcibly 

starts , stop, or control another one, the computers are not autonomous. A system with one 

control unit and many slaves is not a network; nor is a large computer with remote printers and 

terminals. 

 

1.2 Data Transmission modes 

The amount of data that can be transmitted over a communication channel. There are several 

modes of data transmission between sender and receiver. 

 

Simplex 

    

Example: Radio, TV  

 

 

 

Example: Walkie-Talkie 

 

Half-duplex 
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Full duplex 

 

Example: Phone, Skype, E-mail 

 

 

Today which allows us to transmit messages to each other, here are some: 

Internet, Web (documents), E-mail, Instant Messaging, Chat Rooms, Newsgroups, FTP, Video 

Conferencing, Modem 

 

Unit 2 Data Transmission Media / Communication channels 

2.1 Guided Transmission Media. 

2.2 Wireless Transmission 

 

Transmission media refers to the many types of cables and other mediums that carry the 

signal from the sender to the receiver. The most basic hardware required for communication is 

the media through which data is transferred.  There are several types of media, and the choice 

of the right media depends on many factors such as cost of transmission media, efficiency of 

data transmission and the transfer rate. 

There are two types of transmission medium  

1. Guided / Wired. - The medium is more important. 

2. Unguided / Wireless - The bandwidth produced by the antenna is more important. 

 

Wireless transmission requires no physical media but relies on electromagnetic waves such as 

those found in television and radio broadcasts. This type of media is such as microwave and 

satellite transmission. 

2.1 Guided Transmission Media 
Some of the following transmission Medias is as follows: 

 

1. Two wire open line:  This is the simplest of all the transmission media.  It consists of a 

simple pair of metallic wires made of copper or sometimes aluminums of between 0.4 and 

1mm diameter, and each wire is insulated from the other.   There are variations to this 

simplest form with several pairs of wire enclosed in a single protected cable called a multi 

core cable or molded in the form of a flat ribbon. 

 

This type of media is used for communication within a short distance, up to about 50 M, and 

can achieve a transfer rate of up to 19200 bits per second. 

 

2. Twisted Pair cable: A twisted pair consists of a pair of insulated conductors that are twisted 

together.  The advantages of a Twisted Pair cable over the Two Wire Open Lines are; it 

provides better immunity from spurious noise signals.  As the Two Wires are closed to each 

other, both pick equal interferences caused by extraneous signal sources and this reduces 

the differential signal added by the noise. 
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Twisted Pair cable is used for communication up a distance of 1 KM and can achieve a transfer 

rate of up to 1-2 MBPS.  But as the speed increased the maximum transmission distances 

reduced, and may require repeaters. 

 

 

 

Twisted pair cables are widely used in telephone network and are increasingly being used for 

data transmission. 

 

3. Co-axial Cable: A co-axial cable consists of a solid conductor running co-axial inside a 

solid or braided our annular conductor.  The space between the two conductors is filled with 

a dielectric insulating material.  Larger the cable diameter, lower is the transmission loss, 

and higher transfer speeds can be achieved.  A co-axial cable can be used over a distance of 

about 1 KM and can achieve a transfer rate of up to 100 MBPS. 

 

 

 

A co-axial cable is of two types- a 75 Ohm cable which is used by the cable TV operators and 

50 Ohm cable which is used in high speed broad band networks and is low loss cables. 

 

4. Fiber Optic Cables:  
 

 

 

 

A fiber optic cable carries signals in the form of fluctuating light in a glass or plastic cable. An 

optical fiber cable consists of a glass or plastic core surrounded by a cladding of a similar 

material but with a lower refractive index. The core transmits the light while the change in 

refractive index. The core transmit the light while the change in refractive index  between the 

core and the cladding causes total internal reflection, thus minimizing the loss of light  from 

fiber. 

 

As light waves gave a much wider wand width then the electrical then the electrical signal and 

are immune from electromagnetic interferences, this leads to high data transfer rate of about 

1000 mega bites per second & can be used for long & medium distance transmission links.  

 

 

2.2 Unguided Transmission Media 
 

Radio, Microwaves & Satellite Channels: 

Radio, Microwaves & Satellite Channels use electromagnetic propagation in open space. The 

advantage of these channels lie in their capability to cove large geographical areas & being 

inexpensive than the wired installation.  

 

The demarcation between radio, Microwave & satellite channels lie in the frequencies in which 

they operate. Frequency bellow 1000 MHZ are radio frequencies & higher the Microwave 
frequencies. 
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The radio frequency transmission may be bellowing 30 MHZ above 30 MHZ & thus the 

techniques of transmission are different. Owing to the characteristics of the ionosphere, 

frequencies bellow 30MHZ are reflected back towards the surface of the earth. Above 30Mhz 

propagation is on line of sight paths. Antennas are placed in between the line-of- sight paths to 

increase the distance. Radio frequencies are prone to attenuation and, thus, they require repeats 

along the path to enhance the signal. Radio frequencies can achieve data transfer rate of 100 

Kbps to 400 Kbps.  

 

Microwave links use line- of- sight transmission with repeaters placed every 100-200 Kms. 

Microwave links can achieve data transfer rates of about 1000 Mbps. 

 

Satellite links use microwave frequencies is the order of 4-12 GHz with the satellite as a 

repeater. They can achieve data transfer rates of about 1000 Mbps. 
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Unit 3 Introduction to Network 

3.1 Network Basics 

3.2 LAN,WAN and MAN 

3.3 Network Topologies 

3.4 Switching Techniques 

3.5 Network Devices 

 

3.1 Network Basics 

Communication using computer has brought a revolution in the world of computer technology, 

particular in the field of computers.  We have always heard of networking or the term network, 

a network is a way or means of transmitting or receiving information one or more. 

In computing networks, the origin of the information request utilized the service of a network to 

locate & return the information.  

Peer networking does not need pre- defined networking addressing. Instead, each resource on 

the network is seen as a peer. Each network resource is a peer to the other network resource. 

When a new network resource joins the network it introduced itself & notifies its peer to any 

other network resources that it knows about peer networks are share network information. 

The entire computer network can be classified into two board categories. They are (a) LAN 

(Local Area Network) (b) WAN (Wide Area Network)    

 

 

3.2 LAN,WAN and MAN 

 

Local Area Networks (LAN): 

Local area network, generally called LANs, is privately-owned networks with in a single 

building or campus of up to a few KM in size. They are widely used to connect personal 

computers and workstation in company offices and factories to share resources (e.g., printers) 

and exchange information. LANs are distinguished from other kinds of networks by three 

characteristics:  

1. Their size, 

2. Their transmission technology, 

3. Their topology. 

 

LANs are restricted in size, which means that the worst-case transmission time is bounded and 

known in advance. Knowing this bound makes it possible to use certain kinds of designs that 

would not otherwise be possible. It also simplifies network management. 
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Metropolitan Area Networks (MAN): 

A metropolitan area network, or MAN (plural: MANs, not MEN) is basically a bigger 

version of a LAN and normally uses similar technology. It might cover a group of nearby 

corporate offices or a city and might be either private or public. A MAN can support both data 

and voice, and might even be related to the local cable television network. A MAN just has 

one or two cables and does not contain switching elements, which shunt packets over one of 

several potential output lines. 

 

Wide Area Networks (WAN): 

A wide area network, or WAN, spans a large geographical area, often a country or continent. 

It contains of machines intended for running user (i.e., application) programs. We will follow 

traditional usage and call these machines hosts. The term end system is sometimes also used 

in the literature. The hosts are connected by a communication subnet, or just subnet for short. 

The job of the subnet is to carry messages from host to host, just as the telephone system carries 

words from speaker to listener. By separating the pure communication aspects of the network 

(the subnet) from the application aspects (the hosts), the complete network design is greatly 

simplified. 

In most WANs, the network contains numerous cables or telephone lines, each one connecting 

a pair of routers. If two routers that do not share a cable nevertheless wish to communicate, 

they must do this indirectly, via other routers.  When a packet is send from one router to another 

via one or more intermediate routers, the packet is received at each intermediate router in its 

entirety, stored there until the required output line is free, and the forwarded.  A subnet using 

this principle is called a Point to Point, store and forward or packet switched subnet.  Nearly 

all wide area networks (except those using satellite) have store and forward subnet.  When the 

packet are small and all the same size, they often called cells. 

 

Wireless network: 

Mobile computers, such as notebook computers and personal digital assistants (PDA) are the 

fastest growing segment of the computer industries.  Many of the owners of these computers 

have desktop machines on LAN’s and WAN’s back at the office and want to be connected to 

their home base even when away from home or en route.  Since having a wired connection is 

impossible in cars and airplanes, there is a lot of interest in wireless network. 

Wireless networks come in many forms. Some universities are already installing antennas all 

over campus to allow students to sit under the trees and consult the libraries card catalogs.  

Here the computers communicate directly with the wireless LAN in a digital form.  Another 

possibility is using a cellular (i.e. portable) telephone with a traditional analog modem.  Direct 

digital cellular service, called CDPD (Cellular Digital Packet Data) is becoming available in 

many cities.  
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Network Hardware 

It is now time to turn our attention from the application and social aspects of networking to the 

technical issues involved in network design. There is no generally excepted taxonomy into which 

all computer network fit, but two dimensions stand out as important: transmission technologies 

and scale. We will now examine each of these in turns. 

Broadly speaking, there are two types of transmission technologies:  

1. Broadcast networks. 

2. Point-to-point networks. 

 

Broadcast networks: It have a single communication channel that is shared by all the machines 

on the network. Short messages, called packets in certain contexts, sent by any machine are 

received by all the others. An address field within the packet specifies for whom it’s intended. 

Upon receiving a packet, a machine checks the address field. If the packet is intended for itself, 

it process the packet, if the packet is intended for the other machine, it is just ignored. 

Broadcast systems generally also allow the possibility of addressing a packet to all destinations 

by using a special code in the address field. When a packet with this code is transmitted, it is 

received and processed by every machine on the network. This mode of operation is called 

broadcasting. Some broadcast system also support transmission to a subset of a machines, 

something now has multicasting. 

Point-to-point networks: It consists of many connections between individual pairs of machines. 

To go from the source to the destination, a packet on this type of network may have to first visit 

one or more intermediate machines. Often multiple routes, of different lengths are possible, so 

routing algorithm play an important role in point-to-point networks. As a general rule (although 

there are many exceptions), smaller, geographically localized networks tend to use broadcasting, 

where larger usually are point-to-point. 

Whenever we want two devices – transmitting and receiving device to communicate with each 

other, we need hardware’s to achieve that.  We would be discussing about the various hardware 

such as: 

3.1 Sender and Receiver hardware 

3.2 Communication devices 

3.3 Communication channels 

 

Sender and Receiver Hardware:  

Following hardware are used for handling communication messages, data transfer etc.  
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Nodes and workstations: 

Data communication is done using various communication devices and softwares interconnected 

for information exchange.  The devices used to communicate a data in communication network 

are called Workstations.  These workstations may be computer, terminal, printer, telephones and 

other communication devices.  Each workstation is connected to something called a Data 

Communication Network Mode. 

 

LAN (Local Area Network) 

As numbers of system grow within an organization, a need is felt for sharing expensive resource 

and exchanging data and information between systems. This need of information exchange and 

resource and sharing with in a organization has given birth to a local area network or LAN. 

A LAN is a data communication network, which connects many computers or workstation ( 

Computer’s Terminals, Printer etc.) and permits exchange of data & information among 

themselves, with in a localized area, typically confined to a building, or a cluster of buildings. 

The distance between two communications prints connected on the same LAN channels is 

usually up to 02 to 05 kms. 

LANs are not rigidly defined but tend to share most of all of the following characteristics. 

  

 The transmission media is shared by all the connected devices in the network. 

 Each device is connected in the network can either operate stand alone or in the network. 

 Area covered is small. 

 Data transfer rates are high, usually 1 Mbps- 100 Mbps (Million of bits per second). 

 Each device connected in the network can communicate with any other device in network. 

 Cost of setting up the network is usually low. 

 

 

3.3 Network Topologies 

 

LAN Topology  

A network topology refers to the physical lay out of the network in which all the devices are 

connected. This includes all the hardware that makes up the network. The points of the 

connection to the network by the station are calls Nodes or Link stations. There are several types 

of topographical design & strategies are used to implement LAN. The majority of these are based 

on three types of topologies.  a) Star  b) Bus  c) Ring 

Each topology has its advantages & disadvantages. 

 

Star Topology  

Star topology is shown bellow. In this topology. A number of stations are connected directly to 

a central station or controller. Communication on the connecting links between the stations & 
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the central station of the star topology can be bi- directional and are point to point. A station on 

this type of network passes an information frame to the central controller, which then forwards 

the information to the destination station. The central controller manage and controls all 

communication between stations on the network.  

 

        

 

 

 

Star Network 

Failure of a station on a star network is easy to detect and can be remove from the network. 

However, failure of the central controller will disable communication through out the whole 

network. 

 

Bus Topology 

 A bus topology is shown bellow all stations are connected to a single communication line. This 

single communication line is referred to a bus. Information frames originating at a station are 

propagated away from the station in both directions on the bus. Each station on the bus 

interrogates the information frame destination address failed for its on addresses. If the 

destination failed does not mach the station address, the station discards the information frame 

back on to the bus. If the destination address matches the station addresses, it accepts the 

information frame & processes the frame. 

An extension to the bus topology is tree topology is in the following figure. Tree topology 

extends the branches of the bus topology allowing more stations to access the bus. 

 

 

 

Bus Topology 

On a bus or tree network there is no central point for management & control.  These function 

ions are distributed to each station on the bus. A brake in the bus can be difficult to locate but 

limits the outage to communications between stations that traverse the broken point.  

 

Ring Topology 

A ring topology is shown bellow. Local area network that have each station attached to an 

adjacent station using point to point links from a physical ring. Each station attached and active 

NODE 

NODE  NODE 

 NODE   NODE 

NODE 

 

NODE 

 

NODE 

 

NODE 
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to the ring regenerate the information frame, then retransmits the information frame on the ring. 

The ring itself is logically circle and the information travels in one direction. 

 

 

 

 

 

 

Failure of a station in a ring topology disrupts the ring because the information frame is not 

regenerated. Additions or deletions of stations of the ring can be disruptive, if the changes are 

not managed properly. 

 

LAN Hardware and Software 

As we have seen so far, to realize a LAN process, several functions are to be performed. These 

are so specialized in nature the require hardware specially built for such purpose. Here we will 

discuss briefly the basic hardware components of LAN, these are: 

a. Transfermission channel 

b. Network Interface Unit (NIU) 

c. Servers 

d. Work Station 

 

a. Transfermission Channels 

Generally following four types of channels are used for data communication in a LAN. They 

are: 

i. Twisted Pair Cable 

ii. Coaxial Cable 

iii. Fiber Optic Cable 

iv. Radio waves 

 

b. Network Interface Units (NIU) 

Network interface units connect each device in the LAN network to shared transmission device. 

It contains the rules or logic to access the LAN. NIU is also used for to implement LAN protocols 

and for device attachments. Its functions depend on the type of topology used in LAN.  

 

 

NODE NODE 

NODE 

NODE 

Ring Topology 
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c. Servers 

One of the major benefits of implementation of LAN is sharing expensive resources such as 

storage device, printer etc. this is achieved through providing servers on the LAN. It is a 

dedicated computer that controls on or more resources. This contains both hardware & software 

for LAN. Three major categories of servers used in LANs are  

i. File Server 

ii. Printer Server 

iii. Modem Server 

In a networking file server is used to share storage space for files. Beside providing storage space 

for files in a LAN environment, it is used for talking periodical backup, and also to provide 

gateway to other servers with in & between LANs. 

Similarly printer server is use to handle printing works of all workstations connected in the 

network. 

In the LAN environment also modem is required to get connected to other network or simply to 

use a telephone. A modem server is used to share these expensive resources by all connected 

workstation in a networking ring. 

 

LAN Software/ Operating System 

As the name suggest LAN operating system is required to operate on the LAN system, manage 

the tremendous work load with a number of various types of server attached to it. It has basically 

two aspects (i) Server Software (ii) Work station Software. As case of other multi user operating 

system, LAN operating system also facilitate the sharing of expensive resources such as printer, 

storage space etc. among all LAN users, provides security of data permits connections to other 

network. 

There are various types of LAN operating systems for example Novel Netware, LAN server, 

omni met, PC Net, IBM PC LAN, Etherlik plus etc. 

 

WIDE Area Network 

As the name suggest, WAN spread across countries and continents satellites being one of the 

transmission media. 

A wide area network WAN is a network that links separate geographical location. A WAN can 

be a public system such as the Public Switched Telephone Network (PSTN) or one of the various 

packet switched services provided by the public telecommunication authorities. WANs can also 

use most other types of other types of circuit including satellite networks, ISDN, Value Added 

Networks (VANs/VADs). 

The network can be a private system made up from the local telephone company or set up using 

public systems as virtual private network. A virtual private network is one which operates in the 
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same way as a private network but which uses public switched services for the transmission of 

information. 

The main distinguishing feature between a LAN and WAN is that, the LAN is under the 

complete control of the owner, whereas the WAN needs the involvement of another authority 

like the telephone company. LANs are also able to handle very high data transfer rates at low 

cost because of the limited area covered. LANs have a lower error rate then WANs. 

 

3.4 Switching Techniques 

In a WAN, two computing devices are not connected directly. A network of switching nodes 

provides a transfer path between the two devices. The process of transferring data blocks from 

one node to another is called data switching.  

There are three switching techniques commonly employed and these are: 

 

1.   Circuit Switching 

In circuit switching there is a dedicated communication path between the sending and receiving 

devices. The dedicated path is a connected sequence of links switching nodes. A conventional 

telephone network, where a dedicated path is set between the called party for the duration of a 

telephone call is an example of circuit switching. 

Communication viz. circuit switching involves three steps-circuit establishment; data transfer; 

and circuit termination. Circuit switching is mainly used for voice telephone network, but is not 

that effective for data communication network, as channel capacities are not fully utilized, as 

data communication equipments do not generate data continuously. 

 

2. Massage Switching 

Massage switching is an alternative switching techni8que, where it is not necessary to establish 

a dedicated path between the sending and receiving devices. In massage switching, the sending 

device appends the destination address to the massage and passes to the network; the massage is 

then passed through the network from one node to another till it reaches the intended destination. 

Each switching are electronic mails, computer files, telegrams and transaction queries and 

responses. A complete exchange may consist of several messages. 

The basic disadvantage of massage switching is the variable delay at intermediate switching 

nodes. 

  

3. Packet Switching 
Packet switching combines the advantages of message & circuiting switching. Packet switching 

is functionally similar to message switching, in which data is transmitted in blocks, stored by 

the first switching node it meets in the network and it forwarded to the next and subsequent 
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downstream nodes until it reaches the destination. The length of data block is limited in packet 

switching network. Typical maximum length of packets is between 128 bytes to 4096 bytes. 

There are two approaches to packet switching: 

 Datagram 

 Virtual circuit 

 

In datagram approach, each packet is treated independently and may follow a different path 

through the network. Packets may be reordered, dropped or delivered in wrong sequence. The 

communication protocols provide the error recovery sequencing of packets at the receiving 

device. 

In virtual circuit approach, a fixed logical path through the network from the sender to the 

receiver is established before any packets are sent. This path remains unchanged for the duration 

of the session. This is quite like circuit switching, but no resources are reserved along the path. 

Packets are buffered at intermediate nodes awaiting transmission. 

 

3.5 Network Devices 

 

WAN Devices / Hardware 

The switching techniques utilized the routine technology of data transfer. Routing is responsible 

for searching a path between two computing devices that wish to communicate and for following 

the data packets on this path. Devices such as bridges, router and gateway provide this routing 

function. 

 

1. Bridges 

Bridges are used to connect two LANs that use identical LAN protocols over a wide area. The 

bridge acts as an address filter which picks up packets from one LAN that are identical for a 

destination on the another LAN and passes these packets on the network. Bridges operate at the 

data link layer (layer 2) of the OSI model. As all devices use the same protocols, the amount of 

processing required at the bridge is minimal. If the distance between the two LANs is large, the 

user would require two additional bridges at either end of the communication link. 

 

2. Routers 

Routers can be used to connect networks that may not be similar. Routers provide connectivity 

between two LANs or two WANs over large geographical distance. Routers operate at the 

network layer (layer 3) of the OSI model. All routers participate in routing protocols to access 

the network topology, and based on this information routers computes the best route from a 

sender to the receiver, 
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3. Gateways 

Gateways are used to connect to dissimilar LANs. The term gateway and routers are used 

interchangeably, though there is a subtle difference between the two. A gateway is required to 

convert data packets from one protocol format to another before forwarding it, as it connects two 

dissimilar networks. 

 

4. What is X.25 
Towards the end of the 1960s, the conman telecommunication carriers around the world 

recognized the need for data communication service that would be distinct from voice circuits. 

The plan was to put together a series of recommendation during the 1970s using ITTCC 

(International telegraph & telephone consultative committee) as the total standards body. This 

ITTCC recommendation series to define the new service was doubled the X series. During the 

1970s sum 60 to 70 recommendations had involved. The most famous of these is X.25, which 

define an interface in to a particular regular data network that of a packet switched network. 

 

Type of WIDE Area Network 

The essential purpose of WIDE Area network, regardless of the size or technology used is to 

link separate locations in order remove data around. A WAN allows these locations to access 

shared computer resources and provides the asocial infrastructure for developing wide spread 

distributed computing system. 

We will now discuss the different types of WAN which are communally used.  

1. Public Networks 

Public networks are those networks which are installed and run by the telecommunication 

authorities and are made available to any organization or individual who subscribe. Examples 

include Public Switched Telephone Networks (PSTN), Public Switched Data Network (PSDN), 

Value Added Service (VANs/ VADs) and the Integrated Service Digital Networks (ISDN). We 

would be discussing the main features of there services: 

 Public Switched Telephone Network (PSTN) 

The features of the PSTN are its low speed, the analog nature of transmission, restricted 

bandwidth & its wide spread availability. As PSTN is designate for telephones, modems are 

required when it is used for data communication. 

 Public Switched Data Network (PSDN) 

The term PSDN covers a number of technologies; all through currently it is limited to Public 

Packet Switch Networks available to the public. The main features of all PSDNs are their high 

label reliability and the high quality of the connection provided. The can support both high & 

low speeds at appropriate costs. 

 Value Added Services (VANs/ VADs) 
In value added services, the provider of such services must process, store and manipulate the 

data that is carried on the network, that add value to it. The technique can be used in specific 
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types of business in which it is advantageous to be able to share information with other 

companies in the same line.  

 Integrated Services Digital Network (ISDN)  
   The ISDN is the networking concept providing for the integration of voice, video and data 

servicing using data service using digital transmission combining both circuits and packet 

switching techniques. The motivating force behind ISDN is that telephone networks around the 

world have been making a transition towards utilizing digital transmission facilities for many 

years. 

2. Private Networks 

The basic technique used in all forms of private WAN is to use private (or more usually leased) 

circuits to link the locations to be served by the network. Between these fixed points the owner 

of the network has complete freedom to use the circuits in any way they want. They can use the 

circuit to carry large quantities of data or for high speed transmission. 

Private WIDE area network can be built using what ever standard technology is available. The 

way private 
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Unit 4 Presentation 

 

4.1 Introduction Presentation  

4.2 Working with the PowerPoint environment 

4.3 Transitions 

4.4 Advancing slides 

4.5  Slide sections 

4.6  Presenting a slide show 

 

 

4.1 Introduction Presentation 

PowerPoint 2013 is a presentation software that allows you to create dynamic slide 

presentations. Slideshows can include animation, narration, images, videos, and much 

more. 

 

Opening PowerPoint 2013 

When you open PowerPoint 2013 for the first time, the Start Screen will appear. From here, 

you'll be able to create a new presentation, choose a template, and access your recently 

edited presentations. 

 

1. From the Start Screen, locate and select Blank Presentation. 

 

2. A new presentation will appear. 

 

Getting to know PowerPoint 2013 

PowerPoint 2013 is similar to PowerPoint 2010. If you've previously used PowerPoint 

2010, PowerPoint 2013 should feel familiar. But if you are new to PowerPoint or have more 

experience with older versions, you should first take some time to become familiar with 

the PowerPoint 2013 interface. 
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Click the buttons in the interactive below to become familiar with the PowerPoint 

2013 interface. 

 

4.2 Working with the PowerPoint environment 

If you've previously used PowerPoint 2010 or 2007, PowerPoint 2013 will feel familiar. It 

continues to use features like the Ribbon and the Quick Access toolbar—where you will 

find commands to perform common tasks in PowerPoint—as well as Backstage view. 

 

The Ribbon 

PowerPoint 2013 uses a tabbed Ribbon system instead of traditional menus. The 

Ribbon contains multiple tabs, each with several groups of commands. You will use 

these tabs to perform the most common tasks in PowerPoint. 

 

Exploring the Ribbon 

You'll need to move between tabs to perform common tasks in PowerPoint. Knowing 

where to find the right command will make PowerPoint easier to use. 

Click the arrows in the slideshow below to learn more about the different commands 

available within each tab on the Ribbon. 

  

The Home tab gives you access to the most commonly used commands, including copy 

and paste, formatting, and the New Slide command. The Home tab is selected by 

default whenever you open PowerPoint. 

 

To minimize and maximize the Ribbon: 

The Ribbon is designed to respond to your current task, but you can choose 

to minimize it if you find that it takes up too much screen space. 

1. Click the Ribbon Display Options arrow in the upper-right corner of the 

Ribbon. 

2. Select the desired minimizing option from the drop-down menu: 
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The Quick Access toolbar 

Located just above the Ribbon, the Quick 

Access toolbar lets you access common 

commands no matter which tab is selected. 

By default, it includes 

the Save, Undo, Repeat, and Start 

Presentation commands. You can add 

other commands depending on your 

preference. 

 

To add commands to the Quick Access toolbar: 

1. Click the drop-down arrow to the right of the Quick Access toolbar. 

2. Select the command you want to add from the drop-down menu. To choose 

from more commands, select More Commands. 

3. The command will be added to the Quick Access toolbar. 

 

The Ruler, guides, and gridlines 
PowerPoint includes several tools to help organize and arrange content on your slides, 

including the Ruler, guides, and gridlines. These tools make it easier to align objects on 

your slides. Simply click the check boxes in the Show group on the View tab to show 

and hide these tools. 

Simply click and drag to move the horizontal or vertical guides to a new position. 

 

Backstage view 

Backstage view gives you various options for saving, opening, printing, and sharing 

your presentations. 

 

To access backstage view: 

1. Click the File tab on the Ribbon. 

2. Backstage view will appear. 

Click the buttons in the interactive below to 

learn more about using backstage view. 

 

 

 

4.3 Transitions 

There are three categories of unique transitions to choose from, all of which can be 

found on the Transitions tab: 

 Subtle: These are the most basic types of transitions. They use simple 

animations to move between slides. 

 Exciting: These use more complex animations to transition between slides. 

While they're more visually interesting than Subtle transitions, adding too many 

can make your presentation look less professional. However, when used in 

moderation they can add an nice touch between important slides. 

 Dynamic Content: If you're transitioning between two slides that use 

similar slide layouts, dynamic transitions will move only the placeholders, not 

the slides themselves. When used correctly, dynamic transitions can 

help unify your slides and add a further level of polish to your presentation. 
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To apply a transition: 

1. Select the desired slide from the Slide Navigation pane. This is the slide that 

will appear after the transition. 

2. Click the Transitions tab, then locate the Transition to This Slide group. By 

default, None is applied to each slide. 

3. Click the More drop-down arrow to display all transitions. 

 

4. Click a transition to apply it to the selected slide. This will automatically 

preview the transition. 

You can use the Apply To All command in the Timing group to apply the same 

transition to all slides in your presentation. Keep in mind that this will modify any 

other transitions you've applied. 

Try applying a few different types of transitions to various slides in your presentation. 

You may find that some transitions work better than others, depending on the content of 

your slides. 

To preview a transition: 

You can preview the transition for a selected slide at any time using either of these two 

methods: 

 Click the Preview command on the Transitions tab. 

 Click the Play Animations command in the Slide Navigation pane. 

 

Modifying transitions 

To modify the transition effect: 

You can quickly customize the look of a transition by changing its direction. 

1. Select the slide with the transition you want to modify. 

2. Click the Effect Options command, and choose the desired option. These 

options will vary depending on the selected transition. 

3. The transition will be modified, and a preview of the transition will appear. 

Some transitions do not allow you to modify the direction. 
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To modify the transition duration: 

1. Select the slide with the transition you want to modify. 

2. In the Duration field in the Timing group, enter the desired time for the 

transition. In this example, we'll increase the time to two seconds—or 02.00—

to make the transition slower. 

 

To add sound: 

1. Select the slide with the transition you want to modify. 

2. Click the Sound drop-down menu in the Timing group. 

3. Click a sound to apply it to the selected slide, then preview the transition to 

hear the sound. 

Sounds are best used in moderation. Applying a sound between every slide could 

become overwhelming or even annoying to an audience when presenting your 

slide show. 

 

To remove a transition: 
1. Select the slide with the transition you want to remove. 

2. Choose None from the Transition to This Slide group. The transition will be 

removed. 

 

To remove transitions from all slides, apply the None transition to a slide, then 

click the Apply to All command. 

. 

 

 

4.4 Advancing slides 

 

Normally, in Slide Show view you would advance to the next slide by clicking your 

mouse or by pressing the spacebar or arrow keys on your keyboard. The Advance 

Slides settings in the Timing group allows the presentation to advance on its own and 

display each slide for a specific amount of time. This feature is especially useful 

for unattended presentations, such as those at a trade show booth. 
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To advance slides automatically: 

1. Select the slide you want to modify. 

2. Locate the Timing group on the Transitions tab. Under Advance Slide, 

uncheck the box next to On Mouse Click. 

3. In the After field, enter the amount of time you want to display the slide. In 

this example, we will advance the slide automatically after 1 minute and 15 

seconds, or 01:15:00. 

 

4. Select another slide and repeat the process until all the slides have the desired 

timing. You can also click the Apply to All command to apply the same 

timing to all slides. 

If you need to advance to the next slide before an automatic transition, you can 

always click the mouse or press the spacebar to advance the slides as normal. 

About slide views 

PowerPoint includes several different slide views, which are all useful for various 

tasks. The slide view commands are located in the bottom-right of the PowerPoint 

window. There are four main slide views: 

 Normal view: This is the default view, where you create and edit slides. You 

can also move slides in the slide navigation pane on the left. 

 Slide sorter: In this view, you'll see a thumbnail version of each slide. You 

can drag and drop slides to reorder them quickly. 

 Reading view: This view fills the PowerPoint window with a preview of your 

presentation. It includes easily accessible navigation buttons at the bottom-

right. 

 Play slide show: This is the view you'll use to present to an audience. This 

command will begin the presentation from the current slide. You can also 

press F5 on your keyboard to start from the beginning. A menu will appear 

when you hover the mouse in the bottom-left corner. These commands allow 

you to navigate through the slides and access other features, such as 

the pen and highlighter. 
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Outline view 

Outline view shows your slide text in outline form. This allows you to quickly edit 

your slide text and view the content of multiple slides at once. You could use this 

layout to review the organization of your slide show and prepare to deliver your 

presentation. 

 

To view an outline: 
1. From the View tab, click the Outline View command. 

 

2. An outline of your slide text will appear in the slide navigation pane. 

3. You can type directly in the outline to make changes to your slide text. 

 

Slide notes:- You can add notes to your slides from the Notes pane. Often 

called speaker notes, they can help you deliver or prepare for your 

presentation. 

 

To add notes: 

1. Click the Notes command at the bottom of the screen to open the Notes pane. 

2. Click and drag the edge of the pane to resize it if desired. 

3. Click the Notes pane, and begin typing to add notes. 

You can also access Notes Page view to edit and review your notes. Just click 

the Notes Page command from the View tab. From there, you can type notes in 

the text box below each slide.  

 



28 

 

4.5 Slide sections 

If you have a lot of slides, you can organize them into sections to make your 

presentation easier to navigate. Sections can be collapsed or expanded in the slide 

navigation pane and named for easy reference. 

To create slide sections: 

In our example, we will add two 

sections: one for dogs that are 

available for adoption, and 

another for cats and other pets. 

1. Select the slide you want to 

begin a section. 

2. From the Home tab, click 

the Section command, then 

choose Add Section from 

the drop-down menu. 

3. An Untitled Section will 

appear in the slide 

navigation pane. 

4. To rename the section, click 

the Section command, then 

choose Rename Section from the drop-down menu. 

 

5. Type the new section name in the dialog box, 

then click Rename. 

 

6. Repeat to add as many sections as you need. 

7. In the slide navigation pane, click 

the arrow next to a section name to collapse or expand it. 

To remove a section, click 

the Section command, then 

click Remove Section. You can also 

click RemoveAll Sections to remove all 

sections from your slides.  
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4.6  Presenting a slide show 

Before you present your slide show, you'll need to think about the type of equipment that 

will be available for your presentation. Many presenters use projectors during 

presentations, so you might want to consider using one as well. This allows you to control 

and preview slides on one monitor while presenting them to an audience on another 

screen. 

To start a slide show: 

 Click the Start From Beginning command on the Quick Access toolbar, or 

press the F5 key at the top of your keyboard. The presentation will appear in 

full-screen mode. 

 

You can also click the Play Slide Show command at the bottom of the PowerPoint 

window to begin a presentation from the current slide. 

Click the Slide Show tab on the Ribbon to access even more options. From here, 

you can start the presentation from the current slide and 

access advanced presentation options. 

 
To advance and reverse slides: 

You can advance to the next slide by clicking your mouse or pressing the spacebar on 

your keyboard. Alternatively, you can use or arrow keys on your keyboard to move 

forward or backward through the presentation. 

 

You can also hover your mouse over the bottom-left and click the arrows to move 

forward or backward. 

 

To stop a slide show: 

You can exit presentation mode by clicking the Esc key on your keyboard. 

Alternatively, you can click the Slide Show Options button in the bottom-left and 

select End Show. 

The presentation will also end after the last slide. You can click the mouse or press 

the spacebar to return to Normal view. 

 

 

 

 
 

 



30 

 

Unit 5 Drawing and Modifying Object 

 

5.1 Presentation tools and features 

5.2 Slide options 

5.3 Animation Effect 

5.4 Working with animations 

5.5 The Effect Options dialog box 

 

5.1 Presentation tools and features 

PowerPoint provides convenient tools you can use while presenting your slide show. For 

example, you can change your mouse pointer to a pen or highlighter to draw attention 

to items in your slides. In addition, you can jump around to slides in your presentation 

or access other programs from your taskbar if needed. 

 

To access drawing tools: 

Your mouse pointer can act as pen or highlighter to draw attention to items in your 

slides. 

1. Locate and select the Pen Tools button in the bottom-left corner. 

2. Select Pen or Highlighter based on your preference. 

3. Click and drag the mouse to mark your slides. You can also press Ctrl+P on 

your keyboard to access the pen tool while presenting your slide show. 

 

You can also use the laser pointer feature to draw attention to certain parts of 

your slide. Unlike the pen and highlighter, the laser pointer will not leave markings 

on your slides. To use the laser pointer, select it from the Pen Tools, or press and 

hold the Ctrl key and the left mouse button. 

 

To erase ink markings: 

1. Locate and select the Pen Tools button in the bottom-left corner. 

2. Select Eraser to erase individual ink markings, or select Erase All Ink on 

Slide to erase all markings. 

When you end a slide show, you'll also have the option to Keep or Discard any 

ink annotations made during your presentation. If you keep ink markings, they'll 

appear as objects on your slides in Normal view. 

 

To skip to a nonadjacent slide: 

You can jump to slides out of order if needed. 

1. Locate and select the See All Slides button in the bottom-left corner. 

2. Thumbnail versions of each slide will appear. Select the slide you want to 

jump to. 

3. The selected slide will appear. 

 

 

To show the taskbar: 
Sometimes you may need to access the Internet or other files and programs on your 

computer during your presentation. PowerPoint allows you to access 

your taskbar without ending the presentation. 

1. Locate and select the Slide Options button in the bottom-left corner. 
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2. Select Screen, then click Show Taskbar. 

3. Your taskbar will appear. Choose a program you want to open, such as a web 

browser. Click the PowerPoint icon to return to the presentation. 

 

 

5.2 Slide options 

You can also access any of the menu items above by right-clicking anywhere on the 

screen during your slide show. 

 

Presenter view 
If you're presenting your slide show with a second display—like a projector—you can 

use Presenter view. Presenter view gives you access to a special set of controls on your 

screen that the audience won't see, allowing you to easily reference slide notes, preview 

the upcoming slide, and much more. 

 

To access Presenter view: 

Start your slide show as you normally would, then click the Slide Options button 

and select Presenter View. Alternatively, you can press Alt+F5 on your keyboard 

to start the slide show in Presenter view. 

 

Click the buttons in the interactive below to learn more about using Presenter view. 

 

Slide show setup options 
PowerPoint has various options for setting up and playing a slide show. For example, 

you can set up an unattended presentation that can be displayed at a kiosk and make 

your slide show repeat with continuous looping. 

To access slide show setup options: 

1. Select the Slide Show tab, then click the Set Up Slide Show command. 

 

2. The Set Up Show dialog box will appear. From here, you can select the 

desired options for your presentation. 

Click the buttons in the interactive below to learn about various options for setting 

up and playing a slide show. 
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To advance slides automatically, you'll need to customize the slide timing on 

the Transitions tab. Review our lesson on Applying Transitions to learn how. 

 

 

5.3   Animation Effect 

 
There are several animation effects you can choose from, and they are organized into 

four types: 

 Entrance: These control how the object enters the slide. For example, with 

the Bounce animation the object will "fall" onto the slide and then bounce 

several times. 

 Emphasis: These animations occur while the object is on the slide, often 

triggered by a mouse click. For example, you can set an object to spin when 

you click the mouse. 

 Exit: These control how the object exits the slide. For example, with 

the Fade animation the object will simply fade away. 

 Motion Paths: These are similar to Emphasis effects, except the object moves 

within the slide along a predetermined path, like a circle. 

https://www.gcflearnfree.org/powerpoint2013/applying-transitions/1/
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To apply an animation to an object: 

1. Select the object you want to 

animate. 

2. On the Animations tab, click 

the More drop-down arrow in 

the Animation group. 

3. A drop-down menu of 

animation effects will appear. 

Select the desired effect. 

4. The effect will apply to the 

object. The object will have a 

small number next to it to show 

that it has an animation. In the 

Slide pane, a star symbol also 

will appear next to the slide. 

At the bottom of the menu, you can 

access even more effects. 

 

 

Effect options 

Some effects will have options you can change. For example, with the Fly In effect 

you can control which direction the object comes from. These options can be accessed 

from the Effect Options command in the Animation group. 

To remove an animation 

1. Select the small number located next to the animated object. 

2. Press the Delete key. The animation will be deleted. 

 

 

 

 

5.4  Working with animations 
 

To add multiple animations to an object: 

If you select a new animation from the the menu in the Animation group, it will replace 

the object's current animation. However, you'll sometimes want to place more than 

one animation on an object, like an Entrance and an Exit effect. To do this, you'll need 

to use the Add Animation command, which will allow you to keep your current 

animations while adding new ones. 

1. Select an object. 

2. Click the Animations tab. 

3. In the Advanced Animation group, click the Add Animation command to 

view the available animations. 

4. Select the desired animation effect. 

5. If the object has more than one effect, it will have a different number for each 
effect. The numbers indicate the order in which the effects will occur. 
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To copy animations with the Animation Painter: 

In some cases, you may want to apply the same effects to more than one object. You can 

do this by copying the effects from one object to another using the Animation Painter. 

In our example, we want text to appear on our banner shape, so we've added a text box 

on top of the banner. We'd like the text to appear using the same effects we used on the 

banner, so we'll use the Animation Painter to copy the effects from the banner to the text 

box. 

1. Click the object that has the effects  you want to copy. In our example, we'll 

click our banner shape. 

2. From the Animations tab, click the Animation Painter command. 

3. Click the object you want to copy the effects to. The effects are applied to the 

object. In our example, the effects from the shape are applied to the text box. 

 

To reorder the animations: 

1. Select the number of the 

effect you want to change. 

2. From the Animations tab, 

click the Move 

Earlier or Move 

Later commands to change 

the ordering. 

 

To preview animations: 

Any animation effects you have applied 

will show up when you play the slide 

show. However, you can also 

quickly preview the animations for the 

current slide without viewing the slide 

show. 

1. Navigate to the slide you want to 

preview. 

2. From the Animations tab, click 

the Preview command. The 

animations for the current slide will 

play. 

 

The Animation Pane 

The Animation Pane allows you to view and manage all of the effects that are on the 

current slide. You can modify and reorder effects directly from the Animation Pane, 

which is especially useful when you have several effects. 

 

To open the Animation Pane: 

1. From the Animations tab, click the Animation Pane command. 

2. The Animation Pane will open on the right side of the window. It will show all 

of the effects for the current slide in the order in which they will appear. 
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If you have several animated objects, it 

may help to rename the objects before 

reordering them in the Animation Pane. 

You can rename them in the Selection 

Pane. To open the Selection Pane, click 

an object, then from the Format tab 

click Selection Pane. Double-click the 

name of an object to rename it. 

 

To reorder effects from the Animation 
Pane:  

1. On the Animation Pane, click and 

drag an effect up or down. 

2. The effects will reorder themselves. 

 

 

To preview effects from the Animation 

Pane: 

1. From the Animation Pane, click 

the Play button. 

2. The effects for the current slide will 

play. On the right side of the 

Animation Pane, you will be able to 

see a timeline that shows the 

progress through each effect. 

 

If the timeline is not visible, click the 

drop-down arrow for an effect, then 

select Show Advanced Timeline. To 

change an effect's start option: 

 

 

By default, an effect starts playing when you click the mouse during a slide show. If you have 

multiple effects, you will need to click multiple times to start each effect individually. 

However, by changing the start option for each effect, you can have effects that automatically 

play at the same time or one after the other 
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1. From the Animation Pane, select an 

effect. A drop-down arrow will appear 

next to the effect. 

2. Click the drop-down arrow. You will 

see three start options: 

o Start on Click: This will start the 

effect when the mouse is clicked. 

o Start With Previous: This will 

start the effect at the same time as 

the previous effect. 

o Start After Previous: This will 

start the effect when the previous 

effect ends. 

3. Select the desired start option. 

 

When you preview the animations, all of 

the effects will play through automatically. 

To test effects that are set to Start on 

Click, you will need to play the slide show. 

 

 

 

 

5.5 The Effect Options dialog box 
 

From the Animation Pane, you can 

access the Effect Options dialog box, 

which contains more advanced options 

you can use to fine tune your 

animations. 

 

To open the Effect Options dialog box: 
1. From the Animation Pane, select 

an effect. A drop-down arrow will 

appear next to the effect. 

2. Click the drop-down arrow, then 

select Effect Options. 

3. The Effect Options dialog box will 

appear. From here, you can add 

various enhancements to the 

effect: 

o Sound: Adds a sound effect to the animation.  

o After animation: Changes the color or hides the object after the animation 

is over 

o Animate text: Allows you to animate text all at once, one word at a time, 
or one letter at a time   
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Some effects have additional 

options you can change. These will 

vary depending on which effect you 

have selected. 

 

To change the effect timing: 
1. From the Effect Options dialog box, 

select the Timing tab. 

 

2. From here, you can add a delay before 

the effect starts, change 

the duration of the effect, and control 

whether or not the effect repeats. 
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Unit 6 Creating a Multimedia Presentation 

 
6.1 What is Slide Master View 

6.2 Using Slide Master view 

6.3 Customizing slide layouts 

6.4 Customizing text formatting 

6.5 Creating new slide layouts 

6.6 To save a theme 

 

 

 

 

 

6.1 What is Slide Master view? 
Slide Master view is a special feature in PowerPoint that allows you to quickly modify 

the slides and slide layouts in your presentation. From there, you can edit the slide 

master, which will affect every slide in the presentation. You can also modify 

individual slide layouts, which will change any slides using those layouts. 

For example, let's say you find a theme you like but you don't like the slide layouts. You 

could use Slide Master view to customize the layouts exactly the way you want them to 

look. 

 

In Slide Master view, the Slide Master tab will appear first on the Ribbon, but you'll 

still be able to access commands on different tabs as normal. 

 

6.2 Using Slide Master view 

Whether you're making significant changes to your slides or just a few small tweaks, 

Slide Master view can help you create a consistent, professional presentation without a 

lot of effort. You could use Slide Master view to change just about anything in your 

presentation, but here are some of its most common uses: 

• Modify backgrounds: Slide Master view makes it easy to customize the 

background for all of your slides at the same time. For example, you could add a 

watermark or logo to each slide in your presentation, or you could modify the 

background graphics of an existing PowerPoint theme. 



39 

 

• Rearrange placeholders: If you find that you often rearrange the placeholders on 

each slide, you can save time by rearranging them in Slide Master view instead. When 

you adjust one of the layouts in Slide Master view, all of the slides with that layout will 

change. 

• Customize text formatting: Rather than changing the text color on each slide 

individually, you could use the Slide Master to change the text color on all slides at once. 

• Create unique slide layouts: If you want to create a presentation that looks 

different from regular PowerPoint themes, you could use Slide Master view to create 

your own layouts. Custom layouts can include your own background graphics and 

placeholders. 

Some overall presentation changes—like customizing the theme fonts and theme 

colors—can be made quickly from the Design tab. Review our lesson on Modifying 

Themes to learn more. 

 

To make changes to all slides: 
If you want to change something on all slides of your presentation, you can edit the Slide 

Master. In our example, we'll add a logo to every slide. 

1. Select the View tab, then click the Slide Master command. 

 

 

2. The presentation will switch to Slide Master view, and the Slide Master tab 

will be selected on the Ribbon. 

3. In the left navigation pane, scroll up and select the first slide. This is 

the slide master. 

4. Use the desired tabs on the Ribbon to make changes to the Slide Master. In 

our example, we’ll insert a picture in the upper-left corner of the slide. 

5. Move, resize, or delete other slide objects as needed. In our example, we'll 

resize the background graphic to fit below our newly inserted logo. 

6. When you’re finished, 

click the Close Master 

View command on 

the Slide Master tab. 

 

7. The change will appear 

on all slides of the presentation. 

 

When you make a change to the Slide Master, it's a good idea to review your presentation 

to see how it affects each slide. You may find that some of your slides don't look exactly 

right. On the next page, we'll show you how to fix this by customizing individual slide 

layouts. 
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If you're inserting a background graphic, you may want to send it behind all other 

objects on the slide. Right-click the object, select Send to Back, then click Send to 

Back. Review our lesson on Arranging Objects to learn more. 

 

Now it's your turn! Try adding or moving a shape on the Slide Master and see how it 

affects the rest of your slides. 

 

 

 

6.3 Customizing slide layouts 

 

You can use Slide Master view to modify any slide layout in your presentation. It's easy 

to make small tweaks like adjusting background graphics and more significant changes 

like rearranging or deleting placeholders. Unlike the Slide Master, changes to a slide 

layout will only be applied to slides using that layout in your presentation. 

 

To customize an existing slide layout: 
In our example, our newly added logo overlaps a background graphic in the Content 

with Caption Layout. We'll customize this layout to make room for the logo. 

 

1. Navigate to Slide Master view. 

2. Locate and select the desired layout in the left navigation pane. You can hover 

the mouse over each layout to see which slides are currently using that layout 

in the presentation. 

3. In some layouts, the background graphics may be hidden. To show the graphics, 

uncheck the box next to Hide Background Graphics. 

 

4. Add, move, or 

delete 

any objects as 

desired. In our 

example, we'll move 

the red arrow to 

better show our new logo. 

 

5. If you want to change the 

arrangement of the 

placeholders, you can move, 

resize, or delete any of them. 

In our example, we'll move 

our placeholders down to 

align with the red arrow. 

 

6. When you're finished, click the Close Master View command on the Slide 

Master tab. 

 
7. All slides using the layout will be updated. 

 

https://www.gcflearnfree.org/powerpoint2013/arranging-objects/1/
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To add a new slide with the customized layout, click the bottom half of the New 

Slide command, then select the desired layout. 

You can also move placeholders on the Slide Master, which will move the 

placeholders on multiple slide layouts at the same time. However, some slide layouts 

may still need to be adjusted manually. 

 

 

6.4 Customizing text formatting 

 

You can also customize the text formatting from Slide Master view, including 

the font, text size, color, and alignment. For example, if you wanted to change the font 

for every title placeholder in your presentation, you could modify the master title 

style on the Slide Master. 

Each title placeholder is connected to the master title style on the Slide Master. As you 

can see in the example below, modifying the font on the Slide Master changed the title 

font on each slide. 

 

Rather than customizing 

individual placeholders, you 

could change the theme fonts for 

a presentation. From the Slide 

Master tab, click 

the Fonts command in 

the Background group, then 

select the desired fonts. 

 

 

6.5 Creating new slide layouts 

 

One of the most powerful features of 

Slide Master view is the option to 

create new slide layouts. This is an 

easy way to add interesting and 

unique slide layouts to an existing 

theme. You could even use this 

feature to design an entirely new 

theme, as in the example below. 
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To insert a new slide layout: 

1. Navigate to Slide Master view. 

2. From the Slide Master tab, click the Insert Layout command. 

3. A new slide layout will appear. 

4. The layout will include Title and Footer placeholders by default. Click 

the Title and Footers boxes in the Master Layout group to toggle these 

placeholders on and off. 

5. Click the bottom half of the Insert Placeholder command, then select the 

desired placeholder type. We recommend using the Content placeholder most 

of the time because it can be used for any type of slide content. 

6. Click and drag to draw the placeholder on the slide. You can add more 

placeholders if desired. 

7. Using the other tabs on the Ribbon, you can also add background graphics, 

shapes, or pictures to the slide layout. 

 

To rename a custom layout: 
You'll want to give your 

custom layout a unique 

name so it will be easy 

to find. 

1. Navigate to Slide 

Master view. 

2. Select the desired 

layout, then click 

the Rename command. 

 

3. A dialog box will appear. Type the desired 

name, then click Rename. 

 

 

6.6 To save a theme: 

 

 Select the the Slide Master tab, click the Themes command, then select Save 

Current Theme from the drop-down menu. 

If you're not in Slide Master view, you can save the theme from the Design tab. Just 

click the drop-down arrow in the Themes group, then select Save Current Theme. 
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Unit 7 Database Applications 

7.3 Database Overview 

7.4 Introduction to MS Access 

7.5 Database and Relational Database 

 

 

7.6 Database Overview 

 
A database is basically a collection of data or pieces of information. Whether you know it or not, 

you probably use databases all of the time. 

 

 

7.7 Introduction to MS Access 

 

MS Access 

Microsoft Access is a Relational Database Management System (RDBMS), designed primarily 

for home or small business usage. 

 

Access has traditionally been known as a desktop database system because its functions are 

intended to be run from a single computer (as opposed to a server database application where 

the application is installed on a server, then accessed remotely from multiple client machines). 

 

Having said this, Microsoft Access has included a web solution (as well as its desktop solution) 

since 2010, where it is integrated with SharePoint and, since 2013, SQL Server. This tutorial 

focuses on the desktop solution. 

 

Microsoft Access (or MS Access) is a software package that you install just like any other 

software package, and is bundled as part of the Microsoft Office suite. 

 

Access versus Excel 

You may be wondering what the benefits of using Access are compared with using an Excel 

spreadsheet. Well, it really depends on what you want to do with the data that you're storing and 

how much data you intend to store. 

 

Excel may be fine if you've only got a small amount of data, and if you don't have many attributes 

against each piece of data. It may be fine if you don't have much in the way of relational data 

across multiple worksheets. Once you start storing many attributes against each piece of data, 

and perhaps you find yourself repeating information across multiple worksheets, then it's time 

to start using Access (or another database system if you prefer). 

 

Another important reason for using Access over Excel is, if you need to generate a lot of queries 

and reports. Access is much better suited for doing this compared to Excel. 

 

Access File Extensions 

When you create (and save) a database in Microsoft Access, the database is saved with 
a .accdb extension. This is the file extension you will use the most when developing Access 

databases. Older Access databases used an .mdb extension or sometimes a .mde extension, but 
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in 2007, Microsoft started to phase these out in favor of the .accdb extension. If you're unable to 

open an older database, you may need to convert to .accdb first using a pre-2013 version of 

Access. 

 

Download Microsoft Access 

If you don't currently have Microsoft Access installed on your computer, you can download it 

from the official MS Access website. 

 

Access Versions 

This tutorial uses Microsoft Access 2013. If you're using a different version, the screenshots 

might look a little different. Generally, most of the basic functions remain consistent between 

versions of Access so you should be able to follow along without any problems. 

 

 

Create the Database 

 

The first step to creating a database is to, 

well, create the database! We will create 

a blank database first. Then throughout 

the rest of the tutorial, we'll make 

additions to it so that it suits the needs of 

our favorite space travel company. 

 

Creating a database in Microsoft Access 

is as easy as creating a Word document! 

This lesson demonstrates how to create 

a database in MS Access. 

 

1. You may notice that, when you 

first start Microsoft Access 2013, 

you see the following screen. In this case, you can simply select Blank desktop 

database (then skip to Step 3). 

 

If you already have Access open, you can go to 

the File menu: 

 

2. Choose Blank desktop database. (Skip this step if you already chose Blank desktop 

database at step one). You also have other options, but we'll just use a blank database here: 

 

http://office.microsoft.com/Access


45 

 

3. Choose a name and click Create. 

Let's call it Space Trips. You can 

either use the default location or click 

the folder icon to change the 

location:  

 

 

Your New Database 
 

Once you've completed the above steps, 

you should see a blank database, like this: 

We know this database is blank because 

it only contains one table (called Table1) 

and that table only has one column 

(called ID). So we need to add some 

more columns to the  
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Unit 8 Tables 

8.1 Table Basics and Design 

8.2 Creating Relationship 

 

 

8 Table Basics and Design 

 

Create a Table in Microsoft Access 2013 
 

With database management systems, you 

need to create your tables before you can 

enter data. Microsoft Access makes 

creating tables extremely easy. In fact, 

when you create a database, Access creates 

your first table for you (and calls it Table1). 

 

Normally when you need to create a new 

table, you'll select CREATE > Table from 

the Ribbon toolbar. But we can do that later. 

For now Access has already created our first 

table, so all we need to do is modify that 

table so that it suits our needs. 

 

Using our blank database, we are 

going to 

rename Table1 to Customers. This 

table will have 4 

columns: CustomerId, FirstName, LastName, and DateCreated. 

 

1. Rename the ID field to CustomerId. To do this, Right-click on the ID column and 

select Rename Field. Enter CustomerId when prompted: 

 

2. On the next field, click on Click to Add (unless Access has already opened the menu for 

you) and select Short Text: 

 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_database.cfm
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3. At this point, Access will conveniently highlight/select the field name (currently Field1) so 

that you can name the field. Call it FirstName: 

 

4. Do the same again for the next field (LastName) and select data type Short Text. 

 

5. In the next field, select the Date & Time data type 

and name the field DateCreated 

What we just did was create the column names and 

specify the type of data that can be entered into them. 

Restricting the data type for each column is very 

important and helps maintain data integrity. It can 

ensure that the user enters the data in the intended 

format. It can also guard against accidents like for 

example, inadvertently entering an email address into 

a field for storing the current date. 

You might notice that now when you click on the field names, you can't see or change their data 

types. Instead, if you click on the inverted triangle within a field, you see a different menu of 

options (eg, Sort Oldest to Newest etc) depending on the field's data type. This shows that the 

field is ready for data - once you have data, you can sort it using this menu. 

Don't worry if you accidentally entered the wrong data type. You can change the dataype in the 

Ribbon toolbar by adjusting the data type under the Data Type dropdown (top right area of the 

toolbar). If you can't see this option in the toolbar be sure to select the FIELDS tab first: 

We have just created a database table. We 

did this in Datasheet view. Next we will see 

how it appears in Design view. 

 

 

 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/design_view.cfm
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Design View in Microsoft Access 2013 
So we've just created a table. We did that in Datasheet view. We can also view the table in 

Design view. 

 

What Is Design View? 

Design view enables you to design and set up your database (kind of a "behind the scenes" view 

of your database). This is where you set up and configure your tables, forms, reports, etc. 

 

As you continue working with MS Access, you will find yourself switching between Design 

view and Datasheet view (or in the case of forms, Layout view) often. So it's good to familiarize 

yourself with this concept early on. 

 

Switch to Design View 

The following steps demonstrate how to switch to Design view. 

1. Click on the View icon at the top left (just under the File menu). 

The View icon currently looks like this: 

 

2. At this point, Access will ask you to name and save the table you just created. 

Type Customers and click OK 

 

3. You are now looking at your Customers table in Design view. Click on the Date 

Created field, then in the bottom pane, enter =Now() in the Default Value field. 

4. Also click in the Format field and select General Date from the contextual menu: 

 

We have just set a default value for the DateCreated field. This means that, whenever a new 

record is entered, this field will automatically be populated with the current date and time. We 

have also specified a format for all dates that are stored in this field. 

You can see that we have 

configured just two of 

many options in this pane. 

These options can be used 

to further specify exactly 

what type of data can be 

entered into the database 

as well as any constraints 

or defaults that you'd like 

to set against each field. 

Some options include 

restricting the length of 

data (under Field Size), 

setting a default value 

(which we've just done), 

specifying whether it is a 

required field, and more. 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_table.cfm
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In practice, you will 

probably want to tighten 

some of these rules down - 

like specifying whether a 

field is a required field or 

not (i.e. can't be left blank). 

But for the purposes of this 

tutorial, we won't get too 

fussy. 

 

You'll also see that the 

Ribbon now has 

a DESIGN tab with a new 

set of design-related 

options. 

 

 

 

Primary Key 

You might have noticed the little "key" icon to the left of the  CustomerId field. This indicates 

that the field is a primary key. A primary key ensures that the data in this column is unique - no 

two values can be the same. This is important for when you want to perform queries or run 

reports against the table, and it is vital for establishing relationships with other tables. 

 

Datasheet View 
Now that we're in Design view, you might have noticed that the View icon looks 

different - it has changed from a Design view icon into a Datasheet view icon. It now 

looks like this: 

 

Click the View icon to return to Datasheet view, and we'll look at the options for adding data to 

our table. 

 

 

 

Adding Data in Microsoft Access 2013 
 

In Microsoft Access, there are many ways to add data to your database. Which method you 

choose will depend largely on how much data you need to add and whether the data already 

exists outside of Access. 

Here's an explanation of the main methods of adding data to a database. 

 

Datasheet View 

You can type directly into the table while it's in Datasheet view. While this is fine for smaller 

tables with a small number of records that are rarely updated, it's not suitable if you plan to 

maintain a lot of records. Maintaining even a small database can become a time-consuming task 

if records change frequently - especially if you need to update data that's spread across multiple 
tables. It's also not really suitable if there will be non-technical users maintaining the database. 

For non-technical users, it's better to create a nice user-friendly form. 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_relationship.cfm
https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/adding_data.cfm
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Form 

You can set up a form, so that non-technical users can enter data into the form. Once they submit 

the form, the data is automatically inserted into the database. One of the great things about forms 

is that they can insert into many tables - saving you from having to open up each table to 

manually insert the data. 

Access provides a form wizard, which steps you through the process to building a form. We'll 

cover this in the next lesson. 

 

 

SQL View 
You can use SQL view to insert data into your database. You can also use SQL view to do many 

other things with your database (including creating tables). SQL (which stands for Structured 

Query Language) is the standard programming language for working with databases. 

To select SQL View from the Ribbon, select CREATE > Query Design, (close the popup table 

- called Show Table), then select SQL View. 

 

External Data 
There may be times when you need to load your database with data that already exists. For 

example, you might have data in an Excel spreadsheet or even a .csv file that you want to transfer 

to an Access database. This can be done! 

 

Access 2013 allows you to import data from the following file types: 

 Microsoft Excel 

 Microsoft Access 

 ODBC Databases, such as SQL Server 

 Text or comma-separated value (CSV) files 

 SharePoint List 

 XML 

 Data Services 

 HTML Document 

 Outlook folder 

 

To import data from any of these file 

types, select EXTERNAL 

DATA from the Ribbon, select the file 

type, then follow the prompts: 

 

You can also use this menu to link to 

various file types (as opposed 

to import them). Doing this will enable 

you to provide up to date data from 

external databases or files. This option 

does carry some restrictions 

depending on the file type.  
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Access 2013 can link to the following file types: 

 

 Microsoft Excel (read-only) 

 Microsoft Access 

 ODBC Databases, such as SQL Server 

 Text or comma-separated value (CSV) files (add new records only) 

 SharePoint List 

 Data Services (read-only) 

 HTML Document 

 Outlook folder 

 

For now, we will create a form to enter data into our Customers table. 

 

 

 

8.2 Create a Relationship in Microsoft Access 2013 
 

A primary feature of relational databases is that they contain multiple tables, each of which can 

have a relationship with any of the other tables. So far we've only created one table and it's a bit 

difficult trying to establish a relationship with another table when you're the only table in the 

database! 

 

Our database needs more than one table anyway, because we need to be able to track not only 

customers, but also products, as well as the products the customers actually purchase. 

 

So let's create two more tables and establish a relationship between them. One table will 

hold product information, the other will hold order information. 

 

Create the Related Tables 

 

Go ahead and create two 

tables as follows. 

 

 

  

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_form.cfm
https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_table.cfm
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Be sure to set a format and default value for the DateCreated fields on both tables (the user 

shouldn't need to enter this field - the system can do that). 

 

 

Primary Key 

 

Remember that the key icon indicates that the field is a primary key. A primary key ensures that 

the data in this field is unique - no two values can be the same. A table must have a primary key 

before a relationship can be established with another table. Access automatically sets the ID field 

as a primary key, so as long as you simply rename ID to ProductId (or OrderId as the case may 

be) it will already be a primary key. If for some reason your table doesn't have a primary key 

set, or if you want to change the primary key field, you can simply right click on the field header 

(in Design view), and select Primary Key from the contextual menu. 

 

Establish the Relationship 

 

Now that you've created two extra tables, our database has three tables. Now it's time to create 

the relationship between all three tables. 

 

1. While viewing a table in Design view, and ensuring that the DESIGN tab is selected, 

click Relationships from the Ribbon:  
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2. A Show Table dialog box 

will pop up, displaying 

all three tables. Select all 

of them and click Add:  

 

3. Click Close to close the 

dialog box 

4. You will now see three 

boxes which represent 

your three tables. Click 

and drag 

the CustomerId from 

the Customerstable 

across to the 

corresponding CustomerId field on 

the Orders table:  

 

5. The Edit Relationships dialog will 

pop up. Click Enforce Referential 

Integrity so that it is checked. 

Check that t he values are the same 

as the following screenshot and 

click OK: 

 

You will now see a line established 

between the CustomerId field on 

the Customers table and the CustomerId on the Orders table. 

6. Now do the same for the Products table. That is, click and drag the ProductId from 

the Products table across to the corresponding ProductId field on the Orders table. Your 

table relationships should look like the ones in the following screenshot: 
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Relationship Types 
We just established 

a many-to-many 

relationship. There 

are three types of 

relationships that 

you can establish 

between tables. 

These are as 

follows: 

 

Many-To-Many Relationship 
This is what our example above uses. A row in table A can have many matching rows in table 

B, and vice versa. In our case, a single customer can order many products, and a single product 

could have many customers. You create a many-to-many relationship by using a third table, 

called a junction table (more on that below). 

 

One-To-Many Relationship 
This is the most common relationship type. You don't need a third (junction) table for this type 

of relationship. In this type of relationship, a row in table A can have many matching rows in 

table B, but a row in table B can have only one matching row in table A. For example, a row in 

a Gender table (which contains the records Male and Female) can have many matching rows in 

a Customers table, but a row in the Customers table can only have one matching row in the 

Gender table. That is unless there was a business rule that allowed customers to be 

male and female at the same time. In this case, a many-to-many relationship would need to be 

established. 

 

One-To-One Relationship 
A row in table A can have only one matching row in table B, and vice versa. This is not a 

common relationship type, as the data in table B could just have easily been in table A. This 

relationship type is generally only used for security purposes, or to divide a large table, and 

perhaps a few other reasons. 

The type of relationship that you use depends on the table structure and how the fields are  

 

 

Primary Key vs Foreign Key 

We already know that a primary key ensures that the data in the field is unique. This is important 

because our Orderstable needs a unique value in order to reference any record from the other 

tables. For example, it can't use the FirstName field because there could be more than one person 

with a given first name. And it can't use the DateCreatedvalue because it's possible that two 

records could be created at exactly the same time (eg, if two operators are entering data or if 

many records are imported from an external source). This is why we need at least one field that 

we know will only ever contain a unique value. 

 

A foreign key is simply the primary key's corresponding field in the related table. So in our 
example, the CustomerId field in the Orders table is a foreign key, while the CustomerId field 

in the Customers table is a primary key. Likewise, the ProductId field in the Orders table is a 
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foreign key, while the ProductId field in the Products table is a primary key. The fields don't 

necessarily need to have the same names but it's a good practice to get used to. It will definitely 

make the database structure easier to understand - especially when you start adding more tables 

that also need to have relationships established. 

 

 

 

Unit 9 Queries 

9.1 Introduction to Query 

9.2 Working with Query 

 

 

9.1 Introduction to Query 

 

Create a Query in Microsoft Access 2013 
A query refers to the action of instructing the database to return some (or all) of the data in your 

database. In other words, you are "querying" the database for some data that matches a given 

criteria. The queries are run against one or more tables to return only the data that you're 

interested in. 

For example, you might like to see a list of all individuals whose last name is "Griffin". Or you 

might like to see a list of all users who have registered with your database over a given time 

period. You might also want to see which customers have ordered a particular product. To do all 

this, you need to perform a query. 

 

Sample Data 

Before we start querying the database, we should probably make sure we've got enough data in 

there first. Otherwise it doesn't matter how good our queries are - they will all return zero results 

if there's zero data. So let's add some data. 

Remember, the ID columns and DateCreated columns are automatically generated, so you only 

need to enter data into two columns in each table. 

 

Customers Table 
Feel free to make up 

your own data. Here's 

mine: 

 

Products Table 
Feel free to make up 

your own data. Here's 

mine: 
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Orders Table 
Again, feel free to make up your own but you will need to make sure that the value in 

the CustomerId and ProductIdfields match an actual ID in the respective tables. For example, if 

your Orders table contains a CustomerId of 5, you will need to make sure there's an actual 

customer in the Customer table with a CustomerId of 5. Here's some sample data for the Orders 

table: 

 

 

Referential Integrity 

When you create a relationship, you also have the option to Enforce Referential Integrity (which 

we selected when we created our relationship). This prevents foreign key values from having no 

corresponding primary key value in the referenced table. 

Using our tables as an example, let's say you have 10 records in the Customers table (with a 

CustomerId of 1 to 10), but your Orders table contains a record using a CustomerId of 11. In this 

case, referential integrity has not been maintained. If you had enforced referential integrity on 

the relationship (as we have), Access would prevent this from happening. 



57 

 

Below is a screenshot of what will happen if you attempt to enter a value that would breach 

referential integrity. In this case I tried to enter a CustomerId of 50 and a ProductId of 50, but 

my Customers and Products tables don't have a CustomerId of 50 or a ProductId of 50: 

Note that you will only get this message if you have enabled Enforce Referential Integrity. If 

you hadn't enforced referenctial integrity, Access would have happily let you enter the 

meaningless values and the referential integrity of your database would have flown out the 

window. 

 

 

 

9.2 Working with Query 

 

Create the Query 

Now let's create a query that returns the names of all 

customers who have ordered a product. 

1. Ensuring you have the CREATE tab open on the 

Ribbon, click Query Design 

 

2. The Show Table dialog box will appear with all of 

our tables listed. Select all three tables and 

click Add, then click Close:  
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3. The three tables are now represented in the top pane (beneath the Ribbon). Choose the 

fields you'd like to be presented in the results of your query.  

4. You can either double click on the field name or click and drag it down to a column in the 

bottom pane. Select the fields as follows: 
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5. Click the Run button at the top-left part of the Ribbon: 

6. You should now see the result of the query. Here's mine: 

7. Save the query by right-clicking on the Query1 tab and giving it a name. Call it Customer 

Orders: 

 

 

So What Does Our Query Actually Do? 
Our query successfully returns a all customers who ordered at least one product and it includes 

the product and its price next to their name. You can also see that some customers have ordered 

more than one product. The query has automatically joined the three tables using the relationship 

that we created and returned the matching data. 

 

This query will only return those customers who have ordered at least one product. If a customer 

is in the Customers table but does not order a product, that customer's record will not be 

displayed in the results of this query. If you look back at the Customers table (near the top of 

this page), you'll see that Marge Simpson is a customer but she hasn't ordered any products yet 

(i.e. she doesn't have a corresponding 

record in the Orders table). Well actually, 

Marge is only a potential customer. She 

simply expressed interest in buying a space 

ship. But that didn't stop the pesky sales 

person from adding her name into the 

database! 

In any case, the query has done its job. We 

didn't want to see a big list of customers that 

haven't ordered anything yet. 

Next we're going to modify our query so we 

can look at some of the other things we can 

do with queries. 

 

 

 

Modify a Query in Microsoft Access 2013 
 

OK so we just created a query to return all customers in our database who have ordered a product. 

Now we'll see if we can tweak the query a little bit here and there to see what other results we 

can return. 

 

Product Name 

The marketing department wants to see who, if anyone, ordered their most expensive space ship. 

So, let's return a list of all customers who purchased the most expensive space ship - the "Venus 

Carrera ET". 

 

 From Design view, in the bottom pane, enter "Venus Carrera ET" (double quotes included) 

into the Criteria field of the ProductName field: 

 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/modify_a_query.cfm
https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_query.cfm


60 

 

 
 

 

 Click the Run button in the Ribbon to view the results of the query. Alternatively, you can 

just click the Datasheet View icon. And here's the result: 

 

 Once you're satisfied with the results, return to Design view and remove your modification 

(i.e. remove "Venus Carrera ET" from the Criteria field). 

 

 

 

 

Price 

You could also modify your query so that it returns customers who purchased a product worth 

over a certain price. 

 

So let's construct a query that returns all customers who purchased any product with a price 

over $80,000. 

1. From Design view, in the bottom pane, add (>80000) into the Criteria field of 

the Price field: 
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2. Click the Run button in the Ribbon to view the results of the query. Alternatively, you 

can just click the Datasheet View icon. And here are the results: 

 

Price Using Totals 
The previous query is all good and well, but there's one (potential) problem with it. While it 

certainly allows us to see all customers purchased a product over $80,000, it doesn't really paint 

the full picture. It doesn't display those customers who may have purchased more than one 

product, each of which is less than $80,000, but the total of which is more than $80,000. 

Here's how we can capture that one. 

1. From Design view, click the Totals button in the Ribbon: 

 

2. You will now see a Total row in the bottom pane. Each field will have Group By. In 

the Price field, click Group By and select Sum. 

3. Click in the next row down (i.e. the Sort field) and select Descending. Keep 

the >80000 criteria in the Price field. 

4. You will also need to delete the ProductName column by selecting it and 

clicking Delete Columns (next to the Totalsbutton on the Ribbon). It should now look 

like this: 

 

5. Run the query. And here are our big spenders: 
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You could spend a lot of time tweaking this one simple query. For example, here's some ideas: 

 

 You could replace >80000 with >=80000 

 You could remove the >80000 altogether 

 You could sort by CustomerId instead 

 You could use >50000 And <80000 (or any other price range) 

 And much more... 

  

Once you're done, you can either save your new query or keep the original query. For the 

purposes of our macro lesson, you might like to keep the original query. However, you can 

always create and save multiple queries if you're so inclined. 

 

So as you can see, queries can be very powerful. Imagine what you could do if you had more 

tables (and data) in your database. 

Just make sure your query names are descriptive of what the query is doing. Otherwise you 

might find it difficult to distinguish between queries once you have a good number of queries 

within your database. 

So far, all our queries have been constructed using Design view (and then checking them in 

Datasheet view). There is actually another view that we can use to create and modify queries. 

That view is SQL View. 

 

 

 

SQL View in Microsoft Access 2013 
The queries that we created and modfied were all done in Design view. This is a user-friendly 

interface that allows you to create queries easily by visualizing the tables used in the query and 

having options made available to you. 

 

But whenever you use Design view to construct a query, behind the scenes, MS Access is 

constructing an SQL statement in order to make the query work. For every query you create, 

there's an SQL statement hiding in the background. 

 

Well it's not quite "hiding"... after all, you can view it any time you wish. To do this, you need 

to go into SQL View. 

 

 

 

Switch to SQL View 

 

To switch to SQL view, you simply click the SQL icon at the 

bottom-right corner of Access: 
 

You can also choose SQL View from the View icon at the top-left of the Ribbon. 

 

SQL Statement 

Once in SQL view, you will see a SQL statement. This SQL statement represents the query that 

you constructed. Here's the SQL view of the last query that we performed: 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_macro.cfm
https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/sql_view.cfm
https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_query.cfm
https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/modify_a_query.cfm
https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/modify_a_query.cfm
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If you're not familiar with SQL, this might look a little scary. But it needn't be that way. That 

SQL statement is simply extracting records from the database using our precise criteria. 

Let's look at a less complex SQL statement: 

 

 
SELECT Customers.FirstName, Customers.LastName  

FROM Customers 

 

The above SQL statement returns the FirstName and LastName fields from the Customers table. 

It returns all records, because we didn't specify otherwise. 

If we wanted to specify only some records, we would need to add some criteria to the statement. 

Here's a modified statement: 

 

 
SELECT Customers.FirstName, Customers.LastName  

FROM Customers 

WHERE Customers.LastName = 'Griffin' 

 

Like the first example, the above SQL statement returns the FirstName and LastName fields 

from the Customers table. But in this example, we are only returning records where the 

customer's last name is "Griffin". 

As you can see, each time we add criteria to our query in Design view, that criteria is added to 

the SQL statement, and we can limit the results by only those exact records that we are interested 

in. 

These are simple examples to demonstrate how SQL works. Feel free to tweak queries in Design 

view and switch over to SQL view to see how it changes the SQL statement. If you're interested 

in learning more about SQL, check out my SQL tutorial. 

 

 

 

https://www.quackit.com/sql/tutorial/
https://www.quackit.com/sql/tutorial/
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Export Access 2013 Database to Excel 
 

Most Access users will, at some point, need to export their Access database to an Excel 

spreadsheet. OK, most users don't need to export the whole Access database - they will usually 

only need to export a table or the results of a query to Excel. Once in Excel, they can use the 

data as they would normally use data in Excel.  

 

Excel isn't the only format that you might want to export data to. You might want to export from 

Access to XML, HTML, CSV file, or even a PDF file. Fortunately you can do all of these in 

Access 2013. 

 

 

 

Export to Excel 

Here's how you export data from MS 

Access to Excel. 

1. Open the table or query that 

contains the data you want to 

export 

2. Ensuring the EXTERNAL 

DATA tab is selected on the 

Ribbon, click the Excel download 

icon (this is the one with the 

downward facing arrow): 

 

3. Click OK to save the file at the 

default location. Alternatively, 

change the location and/or a file 

name. You can also select any 

other options you wish to include: 

 

4. Click Close. Alternatively, you 

could select Save Export 

Steps before clicking Close. 

You now have an Excel spreadsheet 

containing the data from your query that 

you can send to anyone you like. 

As you can see from the Ribbon, you 

can export to other file types such as 

XML, text file, and even PDF 

documents. The steps are similar to the 

above. Why not try them out? 
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Unit   10 Forms 

 

10.1 Forms Basics 

10.2 Working with Forms 

 

 

10.1 Forms Basics 

 

Create a Form in Microsoft Access 2013 
 

As mentioned, Access forms provide non-technical users the ability to add data to your database. 

Forms also make it easier to insert data across multiple tables. 

 

There are several methods to create a form (as you can see by the following screenshot): 

 

 

Options include using the Form Wizard, Design view, and even starting with a blank form. The 

option you choose will depend on your own preference and perhaps the type of form that you 

want to create. The Navigation option is for creating a form that allows the user to navigate 

database objects such as other forms. The Form Wizard option steps you through the process of 

creating a form. If you use the Form Wizard, you can always modify the form later using Design 

view. 

For the purposes of this tutorial, we'll create our form as quickly as possible. Then we'll go back 

and modify it later. Here's the quickest way to create a form in Access. 

 

1. Ensuring that the Customers table is selected (in the left navigation pane), from the Ribbon, 

select CREATE > Form 

 

 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/adding_data.cfm
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2. Access has just created a brand new form in Layout view, based on the fields in the 

Customers table. Click on the inverted triangle under the View icon and select Form View: 

 

3. This is how the user will see the form. Go 

ahead and enter data into 

the FirstName and LastName fields. Be sure 

to hit Enter after you've entered the last 

name. Then hit enter again to add another 

record. 

 

4. Now let's check our table. 

Click Customers in the left navigation, then 

click Refresh All on the Ribbon. You 

should now see your newly created record 

in the table: 
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You might notice that the Date Created field is 

full of hashes symbols ######. This is because 

the column is currently too narrow to display 

the data. You can resize the column to fit the 

data by double clicking at the side of the column header. First, move the cursor to the edge of 

the column header until it changes appearance into a resize tool, then double click. The column 

should now be wide enough to display the data: 

 

Now let's switch back to the form and save it. 

1. Click on the second tab called Customers (the first one is for the Customers table), then 

click the Save icon in the top left (above the Ribbon): 

 

 
 

2. Rename your form Customers Form when prompted: 

 

 

The form will now appear in the left navigation column under the heading Forms. 
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10.2Working with Forms 

 

Modify a Form in Microsoft Access 2013 
So we've just created a form. While the form works as expected (i.e. it enters data into the 

database table), it could certainly be improved upon. 

Here, we'll give the form a fresh new look and we'll also prevent users from modifying 

the DateCreated field. 

 

Although we've been using the Views icon on the Ribbon to switch views, you can also switch 

views by using the icons at the bottom right of Access (screenshot below). 

 

Design View 
1. Click the Design view icon at the bottom right corner of Access (you can also use the icon 

at the top left of the Ribbon if you prefer): 

 

 

2. Click on the DateCreated field, then click Property Sheet. The Property Sheet will appear 

to the right of the form: 

 

3. On the Property Sheet, scroll down until you see the Locked option. Change its value 

to Yes using the drop down control. 

 

We have just "locked" the DateCreated field so that users can't change it. This field is 

intended to store the date that each record was first entered into the system. Therefore its 

value should never change. By locking the field users can't inadvertently (or even 

maliciously) change it. We can still display the field, for the users' information, but we 

don't want them changing it. 

https://www.quackit.com/microsoft_access/microsoft_access_2013/tutorial/create_a_form.cfm
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4. Next, select the CustomerId label (the label is the one 

on the left - don't touch the ones on the right), and add 

a space so that it becomes Customer Id. Do the same 

for the other fields. This just makes the form a bit 

more readable and more presentable, as the labels are 

what the user sees. It should look like this: 

 

 

 

 

5. Now close the Property Sheet and switch to Layout view. 

 

Layout View 
It's time to give our form a new look. 

1. In Layout view, click in a blank part of the form (i.e. away from the fields). This should 

select the form detail area. 

2. From the Ribbon, select a background color for the form: 

3. Now feel free to format some of the other elements on the page. For example, background 

colors on each field, change the border color of each field, bold the labels, etc. If you want 

to select multiple fields, hold the Shift key down while you select them. You can even 

move fields around by clicking and dragging them. And you can resize the fields by 

clicking and dragging their edges (you can also do it via the Property Sheet). Don't forget 

to save the form once you're happy with it. Here's an example of how a form can look by 

doing just that: 
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Form View 

Now switch 

back to Form 

view and see 

how the form 

looks and works. 

Enter in a few 

records. And a 

few more. You 

can also slide the 

Navigation Pane 

back to make 

more room for 

the form (you 

can do this in 

any view). 

 

 

 

 

Unit 11   Reports 

 

11.1  Report Overview 

11.2  Creating Report 

 

 

11.1 Report Overview 

Reports are used in a database to present information in a neat and organized format that is 

ready for printing. When a report is opened in Access, it is opened in Print preview for this 

reason. Creating a report is very similar to creating a form and like a form, can be done using 

any of the following methods: 

 

 Use an Auto report to create a form based on a standard layout. 

 Use the Report Wizard. 

 Use one of the above methods and then modify the report in Design View. 

 Create a report completely from scratch using the Design View tools. 
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11.2 Creating Report 
 

Creating an Auto Report 
1. Click the Create tab on the Ribbon. 

2. Click the Report icon. 

 

 

 

 

 

 

 

 

 

The buttons in the bottom right of the Window provide access to the different report views. 

 

 The first button selects the standard Report View. 

 The second button shows how the report will look when printed in Print Preview. 

 The last two options are both for modifying the report. The first of these, Layout View, 

allows you to modify the report while the report data is displayed. This provides an easy 

way to make adjustments to the report layout while having a good idea of how the changes 

will affect the report. 

 The last view is Design View .In design view you can ’t see the report ’s data as you make 

changes but it is necessary for some design changes that aren ’t possible with the Layout 

view. 

 

3. Close the report. When prompted, save the report as Student Report: Auto Report. Note 

Reports are for displaying data. You cannot modify table data from a report. 

 

Note Reports are for displaying data. You cannot modify table data from a report. 

 

Using a Report Wizard 

1. Click the Create tab on the Ribbon. 

2. Click . 

 

3. In the Tables/Queries list, make sure that table: STUDENTS is selected. 

4. Select the fields shown above. 

5. Double-click on Student Number and Comment to move them back over to the left as 

shown above. 
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6. Click Next when ready. 

7. The next step allows you to choose grouping levels for your report. Double click on 

Gender to 

select that as the grouping field. This means that all of the female students will be grouped 

together in the report and all the male students will be grouped together. 

8. Click Next to continue 

This step in the wizard allows you to choose how the records in the report will be sorted. There 

are also options for adding totals and subtotals to your report. 

9. In the first sort box, select Last Name as shown above. You can also select additional 

fields for 

sorting in case there are any records with the same last name. 

10. Click Next to move to the next step. 

 

 

 

 

 

 

 

 

11. Select Block for the report layout and click Next 

 

 

 

 

 

 

 


